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1.  Introduction 

1.1  About GFI ReportCenter 

 
Figure 1 - Centralized reporting framework  

GFI ReportCenter is a centralized reporting framework that allows you 
to generate various reports using data collected by different GFI 
products. GFI releases specialized reports for each of its products, 
referred to as a ReportPack; for example, the GFI LANguard 
ReportPack. A ReportPack can be downloaded as an add-on to the 
GFI product. 
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Figure 2 – Several Report Packs plugged into the GFI Report Center framework 

A ReportPack plugs into the GFI Report Center framework; allowing 
you to generate, analyze, export and print the information generated 
through these reports. 

1.2  About the GFI LANguard 9.0 ReportPack 

The GFI LANguard ReportPack is a full-fledged reporting companion 
to GFI LANguard (GFI LANguard). It allows you to generate graphical 
IT-level, technical and management reports based on the network 
security audits carried out by GFI LANguard  

From trend reports for management (ROI) to daily drill-down reports 
for technical staff; the GFI LANguard ReportPack provides you with 
the easy-to-view information required, to fully identify any vulnerability 
on your corporate network.  

The GFI LANguard ReportPack allows for the creation of various 
graphical and text based reports related to: 

 Vulnerability assessment reports 

 Network and software auditing reports 

 Results comparison reports. 

1.3  Components of the GFI LANguard 9.0 ReportPack 

When you install the GFI LANguard 9.0 ReportPack, the following 
components are installed: 

 GFI Report Center framework  

 GFI LANguard 9.0 default reports  

 Report scheduling service.  
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GFI Report Center framework 

The GFI Report Center framework is the management console 
through which you can generate the specialized product reports which 
are shipped with a product ReportPack. The GFI Report Center 
framework offers a common application interface through which you 
can navigate, generate, customize and schedule reports.  

 
Screenshot 1 – The GFI ReportCenter management console 

The GFI ReportCenter management console is organized as follows: 

 

 
Navigation Pane – Use this pane to access the navigation 
buttons/configuration options provided with GFI ReportCenter. 

 
Product Selection drop-down list – Use this drop-down list to select the GFI 
product for which to generate reports. The Product Selection drop-down list 
displays all the products for which you have installed a ReportPack.  

 
Favorite Reports – Use this navigation button to access your favorite/most 
used reports. For more information on how to add reports to this list refer to 
the ‘Adding default reports to the list of favorite reports’ and ‘Adding custom 
reports to the list of favorite reports’ sections in this manual. 

 
Default Reports – Use this navigation button to access the default list of 
reports which can be generated for the selected product. For more 
information on default reports refer to the ‘GFI LANguard default reports’ 
section in this manual. 

 
Custom Reports – Use this navigation button to access the list of 
customized reports which can be generated for the selected product. For 
more information on how to create custom reports refer to the ‘Custom 
reports’ chapter in this manual. 

 
Scheduled Reports – Use this navigation button to access the list of 
scheduled reports for automatic generation and distribution. For more 
information on how to create scheduled reports refer to the ‘Scheduling 
reports’ chapter in this manual. 

 
Options – Use this navigation button to access the general configuration 
settings for the GFI product selected in the Product Selection drop down list.  
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Help – Use this navigation button to show this Quick Reference Guide in the 
Report Pane of the GFI ReportCenter management console. 

 
Report Pane - Use this multi-functional pane to: 

View and analyze generated reports 

Maintain the scheduled reports list  

Explore samples and descriptions of default reports. 

 
Export – Use this button to export generated reports to various formats 
including HTML, Adobe Acrobat (PDF), Excel (XLS), Word (DOC), and Rich 
Text Format (RTF).  

 
Send email – Use this button to instantly distribute the last generated report 
via email.  

GFI LANguard 9.0 default reports  

The GFI LANguard 9.0 default reports are a collection of specialized 
pre-configured reports which plug into the GFI ReportCenter 
framework. These reports present the results of network security 
scans performed by GFI LANguard and allow for the generation of 
both graphical and tabular IT-Level, technical and management 
reports. Default reports can also serve as the base template for the 
creation of customized reports which fit specific network-reporting 
requirements.  

Report scheduling service  

The report scheduling service controls the scheduling and automatic 
distribution of reports by email. Reports generated by this service can 
also be saved to a specific hard disk location in a variety of formats 
which include DOC, PDF, RTF and HTML.  

1.4  Key features 

Centralized reporting 

GFI ReportCenter is a one-stop, centralized reporting framework 
which enables the generation and customization of graphical and 
tabular reports for a wide array of GFI products.  

Wizard assisted configuration 

Wizards are provided to assist you in the configuration, scheduling 
and customization of reports. 

Report scheduling 

With GFI ReportCenter you can schedule reports to be generated on a 
pre-defined schedule as well as at specified intervals. For example, 
you can schedule lengthy reports to be generated after office hours. 
This allows you to maximize the availability of your system resources 
during working hours and avoid any possible disruptions to workflow. 

Distribution of reports via email  

GFI ReportCenter allows you to automatically distribute generated 
reports via email. In scheduled reports, this can be achieved 
automatically after the successful generation of a scheduled report.  
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Report export to various formats 

By default, GFI ReportCenter allows you to export reports to various 
formats. Supported formats include HTML, PDF, XLS, DOC and RTF. 
When scheduling reports, you can optionally configure the preferred 
report output format. Different scheduled reports can also be 
configured to output generated reports to different file formats.  

Default reports 

The GFI LANguard ReportPack ships with a default set of graphical 
and tabular reports. These reports can be generated without any 
further configuration effort immediately after the installation. The 
default reports in this ReportPack are organized into three different 
report-type categories: 

 Vulnerability assessment reports 

 Network and software auditing reports 

 Results comparison reports. 

Report customization 

The default reports that ship with every ReportPack can serve as the 
base template for the creation of customized reports. Report 
customization is achieved by building up custom data filters which will 
analyze the data source and filter the information that matches 
specific criteria. In this way, you create reports tailored to your 
reporting requirements.  

Favorites 

GFI ReportCenter allows you to create bookmarks to your most 
frequently used reports – both default and custom. 

Printing 

By default, all reports generated by GFI ReportCenter are printer 
friendly and can be printed through the windows printing services 
provided by the system where GFI ReportCenter is installed.  
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2.  Installation 

2.1  System requirements 

Install the GFI LANguard ReportPack on a computer that meets the 
following requirements:  

 Windows 2000 (SP4), XP (SP2/SP3), 2003, 2008, VISTA (SP1), 
operating system. 

 Internet Explorer 5.1 or higher 

 .NET Framework version 2.0 

 MDAC 2.8 

 GFI ReportCenter 3.6 

NOTE: The GFI LANguard ReportPack only allows you to generate 
reports for data contained in scan results databases which were 
created and maintained by GFI LANguard  

2.2  Installation procedure 

The GFI LANguard ReportPack includes an installation wizard which 
will assist you through the installation process. During the installation 
process this wizard will:  

 Verify that you are running the latest version of the GFI 
ReportCenter framework; if you are installing the framework for the 
first time or the currently installed framework version is outdated, 
the installation wizard will automatically download the latest one 
for you. 

 Automatically install all the required components distributed 
including the GFI ReportCenter framework, the GFI LANguard 
default reports and the Report Scheduling service.  

To start the installation: 

1. Double-click LANguard9rp.exe.  

2. Select the required language.  

3. Setup will next list all the missing prerequisites (if any). Install any 
missing prerequisites by selecting the prerequisite and choosing Next.  

NOTE: If the current version of your GFI ReportCenter framework is 

not compatible with the GFI LANguard ReportPack, you will be 
prompted to download and install an updated version.  

4. From the welcome screen, click Next. 

5. Read the End User License Agreement, check the I accept the 
license agreement radio button and click Next. 

6. If prompted enter your registration details and license key. Click 
Next to continue setup. 
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NOTE: If GFI LANguard is already installed, GFI ReportPack 

automatically registers the license key of GFI LANguard. 

7. Select installation path or leave it as default and click Next. 

8. Select Launch GFI LANguard 9.0 ReportPack to launch 
ReportPack on setup completion. 

2.3  Launching the GFI LANguard reports for GFI ReportCenter 

Following the installation, launch the GFI LANguard Reports for GFI 
ReportCenter from Start ► Programs ► GFI ReportCenter ► GFI 
LANguard 9 ReportPack. 

2.4  Selecting a product 

When more than one product ReportPack is installed, use the 
Product Selection drop down list to select the GFI product 

ReportPack to be used. 

 
Screenshot 2 – Product Selection drop down list 

For example, to run the reports provided in the GFI LANguard 
ReportPack: 

1. Launch GFI ReportCenter from Start ► Program Files ► GFI 
ReportCenter. 

2. Select GFI LANguard 9.0 from the Product Selection drop down 
list.  

NOTE: Select the ALL PRODUCTS option to display and navigate all 
the ReportPacks that are currently installed in GFI ReportCenter. 
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3.  Getting started: Default reports 

3.1  Introduction 

After installing the GFI LANguard ReportPack, a number of 
specialized pre-configured reports can immediately be generated on 
the data stored in the database backend of GFI LANguard These 
default reports are organized into the following categories: 

 Vulnerabilities Assessment reports: Use the reports in this 
category to identify vulnerabilities detected on the network as well 
information on network patches and service packs installed or 
awaiting deployment  The reports include vulnerability details such 
as host machines, operating systems affected and severity. 

 Network and software audit reports: Use the reports in this 

category to display detailed information on hardware and software 
present on the network. These reports help management in 
analyzing conformance with corporate security policy. 

 Results comparison reports: Use the reports in this category to 
compare results of consecutive network scans that have a 
common profile and target, and of computer scans against a 
computer used as benchmark. 

GFI LANguard default reports are accessed by clicking on the Default 
Reports navigation button provided in the navigation pane.  

3.2  Generating a default report 

To generate a default report: 

1. Click on the Default Reports navigation button to bring up the list 
of default reports available. 
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Screenshot 3 – Selecting the data set 

2. Right-click on the report to be generated, select Run and specify 

the scan date/time period that will be covered by the report.  

Example 1: Generating a “Network Vulnerability Summary” report 
based on the last scan. 

This example demonstrates how to generate a network vulnerability 
summary report based on the last network security scan carried out: 

1. Click on the Default Reports navigation button to bring up the list 

of available reports. 

2. Right-click on Network Vulnerability Summary and select Run ► 
For Last Scan. 

Example 2: Generating a “Network Vulnerability Summary” report 
based on scans made on a particular day. 

This example demonstrates how to generate a network vulnerability 
summary report based on the scan performed on May 11, 2009. 

1. Click on the Default Reports navigation button to bring up the list 

of available reports. 

2. Right-click on Network Vulnerability Summary and select Run ► 
For Custom Date. 
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Screenshot 4 - Configuring custom date/time period 

3. Select the Day option and expand the provided drop down. This will 

bring up the date selection calendar. 

4. Navigate to the required month (i.e. May) and select the required 
day (i.e. 11). 

5. Click Next to generate the report. 

Example 3: Generating a “Network Vulnerability Summary” report 
based on data collected over a specific date/time period. 

This example demonstrates how to generate a network vulnerability 
summary report based on network security scans carried out between 
May 1, 2009 and May 11, 2009. 

1. Click on the Default Reports navigation button to bring up the list 
of available reports. 

2. Right-click on Network Vulnerability Summary and select Run ► 
For Custom Date. 
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Screenshot 5 - Configuring custom date/time period 

3. Select the ‘Date range’ option and specify the required parameters: 

 ‘From’ – 5/1/2009 12:00:00 AM. 

 ‘To’ – 5/11/2009 12:59:59 PM. 

NOTE: Date and time format are based on the regional settings 
configured on your computer. 

4. Click Next to generate the report. 
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3.3  Analyzing the generated report 

 
Screenshot 6 – Generated reports are displayed in the right pane of the management console 

Generated reports are shown in the right pane of the GFI 
ReportCenter. Use the toolbar at the top of the report pane to access 
common report related functions: 

Report browsing options 

 
Browse the generated report page by page. 

 
Zoom in/Zoom out. 

 
Search the report for particular text or characters. 

 
Go directly to a specific page. 

 
Breakdown the report into a group tree (e.g. by date/time). 

 
Print report.  

Report storage and distribution options 

 
Export the generated report to a specific file format. 

 
Distribute the generated report via email. 

NOTE: For information on how to configure report storage and 
distribution options refer to the ‘Configuring Advanced Settings’ 
section in this manual. 
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3.4  Adding default reports to the list of favorite reports 

 
Screenshot 7 – Favorite Reports navigation button 

You can group and access frequently used reports through the 
Favorite Reports navigation button. To add a default report to the list 

of favorite reports: 

1. Click on the Default Reports navigation button to bring up the list 
of available reports. 

2. Right-click on the default report that you to be added to favorites 
and select Add to favorites list. 

3. Click Yes to confirm. 
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4.  Custom reports 

4.1  Introduction 

GFI ReportCenter allows you to create custom reports which are 
tailored to your reporting requirements. This is achieved by building up 
custom data filters which will analyze the data source and filter out the 
information that matches the specified criteria.  

4.2  Creating a new custom report 

To create a custom report: 

1. Click on the Default Reports navigation button. 

2. Right-click on the default report to be used as template and select 
New ► Custom Report. This will bring up the ‘Custom Report 

Wizard’.  

 
Screenshot 8 - Selecting the scan data source to use 

3. Specify the data source option that will be used to generate the 
custom report. This data source refers to scan results from: 

 the last scan 

 particular scan(s)  

 scans carried out over a specific date/time period. 

Click Next to continue.  



 

16  Custom reports GFI ReportCenter 

 
Screenshot 9 – Selecting the scan data source to use 

4. If using the Particular Scan option, select the required scan(s) from 

the list of network security scans carried out on the corporate network. 
Click Next to continue. 

 
Screenshot 10 – Specifying data filter conditions 

5. Configure the data filter conditions that will be applied against the 
selected data source. Click Next to continue. 
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Screenshot 11 - Configuring custom date/time period 

6. If using the Scans over a date/time range option, select the 
date/time period from which network security scan results will be 
gathered. Click Next to continue. 

NOTE: For more information on how to configure filter conditions, 
refer to the section ‘Configuring data filter conditions’ in this manual.  

7. Specify a name and description for the customized report. Click on 
Next to continue. 

8. Click on Finish to finalize your configuration settings. 
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4.3  Configuring data filter conditions 

Use data filter conditions to specify which network security scan 
data/results will be included in the report. Only scans which match the 
specified criteria will be processed and presented within the report.  

 
Screenshot 12 - Custom Report Wizard: Filters dialog 

Click on the Add… button to bring up the ‘Edit filter properties’ dialog 
and configure the following conditions:  

 Filter condition – Specify the data source area on which the filter 
will focus (for example, select ‘Operating System’ to filter the 
events data related to a specific operating system).  

 Condition – Specify the condition comparison parameter.  

 Value – Specify the string to which source data will be compared.  

For example to generate a report which contains only information 
related to Windows XP, configure your filter parameters as shown 
below: 
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Screenshot 13 - Filter conditions configuration dialog 

For more specific reports, you can limit the range of information to be 
displayed by tightening your conditions/search criteria. This is 
achieved by configuring and applying multiple data filters against the 
selected data source. When more than one filter is used, specify how 
these filters will be logically linked. This is achieved by selecting a 
logical grouping condition from ‘Filter property condition…’ drop down 
list.  

 Select And to include ALL the scan data information that satisfies 

ALL of the conditions specified in the filters. 

 Select Or to include ALL the scan data information that matches at 

least one of the specified filter conditions.  
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Example: Using multiple filters 

Consider the situation where a custom report has 2 filters configured 
as follows: 

 
Screenshot 14 - Using multiple filters 

Parameters Filter 1 Filter 2 

Filter condition Hostname Operating System 

Logical relation Is equal to Is equal to 

Value ’Mark’ ‘Windows XP’ 

 

The data which will be included in this custom report will vary 
according to how these filters will be applied against your data. This is 
defined through the ‘Filter property condition…’ drop-down.  

 

Filters applied Data output 

Filter 1 and Filter 2 The report will show: 

All scan data which is related to a host called 
‘Mark’ which runs on ‘Windows XP’. 

Filter 1 or Filter 2 The report will show: 

All scan data related to ‘Windows XP’ – (no 
matter which host it belongs to) 

AND 

All scan data related to a host called ‘Mark’ – 
(no matter which operating system it has 
installed). 

Example: Creating a custom report based on network security 
scans performed during a particular month 

This example demonstrates how to generate a network vulnerabilities 
summary report called ‘Network vulnerabilities summary on hostname 
Mark for January 2009’. This report will be based on scans: 

 Related to a host named ‘Mark’ 

 Corresponding to operating system ‘Windows XP’  

 Performed during the month of ‘January 2009’. 
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To create this report: 

1. Click on the Default Reports navigation button. 

2. Right-click on the report to be customized and select New ► 
Custom Report. This will bring up the ‘Custom Reports Wizard’. 

3. As soon as the welcome dialog is displayed, click Next. 

 
Screenshot 15 – Selecting the data source to use 

4. Select the Scans over a date/month range option and click Next. 

 
Screenshot 16 – Selecting the date/time period  

5. Select the Month option and specify the following parameters: 
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 Month: ‘January’. 

 Year: ‘2009’. 

6. Click on Next to proceed to the data filters dialog. 

 
Screenshot 17 - Filter conditions dialog(s) 

7. Click on the Add… button and configure the parameters of filter 1 
as follows: 

Filter condition: ‘Hostname’  

Condition: ‘Equal to’ 

Value: ‘Mark’. 

8. Click Add to finalize your filter configuration settings. 

9. Click again on the Add… button and configure the parameters of 

filter 2 as follows: 

 Filter condition: ‘Operating system’  

 Condition: ‘is equal to’  

 Value: ‘Windows Vista’  

Filter Property condition…: ‘and’. 

10. Click Add to finalize your filter configuration settings. 

11. Click Next and specify the following parameters: 

 Report Name: ‘Network Vulnerability summary for November 
2008’ 

 Report Title: ‘Network security scans of hostname Mark’ 

 Report Description: ‘This report shows a summary of 

vulnerabilities found on hostname Mark during November 2008.’ 
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12. Click Next to proceed to the final dialog. 

13. Click Finish to finalize your custom report configuration settings. 

4.4  Run a custom report 

To run a custom report: 

1. Click on the Custom Reports navigation button. 

2. Right-click on the custom report to be generated and select 
Generate. 

4.5  Editing a custom report 

To edit the configuration settings of a custom report: 

1. Click on the Custom Reports navigation button. 

 
Screenshot 18 - Custom Report Wizard: Welcome dialog 

2. Right-click on the custom report to be modified and select Edit. This 

will bring up the ‘Custom Reports Wizard’ through which you can 
make the required changes.  

NOTE: For more information on how to configure the parameters of a 

custom report refer to the ‘Creating a custom report’ section in this 
chapter. 
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4.6  Deleting a custom report 

To delete a custom report: 

1. Click on the Custom Reports navigation button. 

2. Right-click on the custom report to be permanently removed from 
the list and select Delete.  

3. Click Yes to confirm. 

4.7  Adding custom reports to the list of favorite reports 

 
Screenshot 19 - Favorite reports navigation button  

You can group and access frequently used reports through the 
Favorite Reports navigation button. To add a custom report to the list 

of favorite reports: 

1. Click on the Custom Reports navigation button to bring up the list 
of available reports. 

2. Right-click on the custom report to be added to favorites and select 
Add to Favorites List. 

3. Click Yes to confirm. 
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5.  Scheduling reports 

5.1  Introduction 

GFI ReportCenter allows you to generate reports on a pre-defined 
schedule as well as at specified intervals. This way you can automate 
the generation of reports that are required on regular basis/ 
periodically.  

Further to this, GFI ReportCenter can also be configured to 
automatically distribute scheduled reports via email. For every 
scheduled report, you can configure custom emailing parameters 
including the list of report recipients and the file format (e.g. PDF) in 
which the report will be attached to the email. 

Use the report scheduling feature to automate your report generation 
requirements. For example, you can schedule lengthy reports after 
office working hours and automatically email them to the intended 
recipients. This way, you maximize the availability of your system 
resources during working hours and avoid any possible disruptions to 
workflow.  

Both default and custom reports can be scheduled for automatic 
generation.  

5.2  Scheduling a report 

To schedule a report: 

1. Click on the Default/Custom Reports option pane. 

2. Right-click on the report to be scheduled and select New ► 
Scheduled report. This will bring up the ‘Scheduled Report Wizard’. 
Click on Next to continue.  

3. Select the network security scan(s) data to be covered by this 
report. 
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 Screenshot 20 – Report Scheduling Wizard: Time schedule dialogue 

4. Specify the report scheduling parameters (date/time/frequency). 
Click on Next to continue.  

 
Screenshot 21 – Report Scheduling Wizard: Advanced Settings dialog 

5. To export the generated report to file, select the Export to file 

option. To customize the report export configuration settings click on 
the Settings button underneath this option. 

NOTE: For information on how to configure export-to-file settings refer 
to the ‘Configuring report export to file options’ section in this chapter. 
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6. To automatically distribute generated reports via email, select the 
Send by mail option. To customize the email settings used for report 
distribution click on the Settings button underneath this option. 

NOTE: For information on how to configure email settings refer to the 
Configuring report emailing options in this chapter.  

7. Specify a name and description for this scheduled report. Click 
Next to continue. 

8. Click Finish to finalize your settings.  

5.3  Configuring advanced settings 

GFI LANguard ReportPack allows you to export scheduled reports to 
a specific file format as well as to automatically distribute these reports 
via email. This is achieved using either a set of parameters (e.g. 
recipient’s email addresses) which are specified on the fly during 
scheduled report configuration or using the default set of report export 
and distribution parameters configured during the ReportPack 
installation.  

NOTE: The Report Scheduling Wizard is by default configured to use 

the default set of report export and distribution parameters. 

Report export formats 

Scheduled reports can be exported in a variety of formats. Supported 
file formats include: 

 

 Format Description 

1 Adobe Acrobat (.PDF) 
Use this format to allow distribution of a report on 
different systems such as Macintosh and Linux 
while preserving the layout. 

2 MS Excel (.XLS) 

Use this format if you want to further process the 
report and perform more advance calculations 
using another (external) program such as 
Microsoft Excel. 

3 MS Word (.DOC) 
Use this format if you want to access this report 
using Microsoft Word. 

4 
Rich text format 
(.RTF) 

Use this format to save the report in a format that 
is small in size and which allows accessibility 
through different word processors in different 
operating systems. 

5.3.1  Configuring report export to file options 

To configure the report export to file settings of a scheduled report do 
as follows: 

 
Screenshot 22 - Advanced Settings dialog: Export to file settings button 

1. From the Advanced Settings dialog, click on the Settings button 
underneath the Export to file option. 
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Screenshot 23 - Advanced Settings: Export to file options 

2. Select the option Override the default folder options for this 
report: 

3. Specify the complete path where the exported report will be saved. 

4. Specify the file format in which the exported report will be saved.  

5. Click OK to finalize your configuration settings. 

NOTE: For information on how to configure the default export to file 

settings refers to the ‘Configuring default scheduling options’ section 
in this manual. 

5.3.2  Configuring report emailing options 

To configure the report emailing options of a scheduled report do as 
follows: 

 
Screenshot 24 - Advanced Settings dialog: Send by email settings button 

1. From the Advanced Settings dialog, click on the Settings button 
underneath the Send by email option. 
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Screenshot 25 - Report distribution options 

2. Select the option Override the default email options for this 
report: 

3. Specify the following parameters: 

 To/CC: Specify the email address (es) where the generated report 
will be sent. 

 From: Specify the email account that will be used to send the 
report. 

 Server: Specify the name/IP of your SMTP (outbound) email 
server. If the specified server requires authentication, select the 
option SMTP Server requires login and specify the logon 
credentials in the User name and Password fields. 

 Report format: Reports are sent via email as attachments. Select 

the file format in which to send out your report.  

4. Click OK to finalize your configuration settings. 
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5.4  Viewing the list of scheduled reports 

 
Screenshot 26 - List of Scheduled reports 

Click on the Scheduled Reports navigation button to show the list of 
scheduled reports which are currently configured for automatic 
generation. This information is displayed in the right pane of the 
management console and includes the following details: 

 Schedule Name: The custom name that was specified during the 
creation of the new scheduled report.  

 Report Name: The names of the default or custom report(s) that 
will be generate. 

 Last Generation: Indicates the date/time when the report was last 
generated.  

 Next Generation: Indicate the date/time when the report is to be 

next generated.  

 Description: The description that you have entered for each 

schedule. 

 Report Pack: The GFI LANguard version that created the report. 
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5.5  Viewing the scheduled reports activity 

 
Screenshot 27 - Schedule activity monitor 

GFI ReportCenter also includes a schedule activity monitor through 
which you can view events related to all scheduled reports that have 
been executed.  

To open the schedule activity monitor, click on the Scheduled 
Reports navigation button and select the Scheduled Reports 
Activity node. This will bring up the activity information in the right 

pane of the GFI ReportCenter management console.  

The activity monitor displays the following events: 

 

 Information: The scheduled report was successfully executed and sent 
by email and/or saved to disk. 

 Warning: The scheduled report was not executed because product 
license is invalid or has expired. 

 Error: The scheduled report was not executed due to a particular 
condition/event. Typical conditions include: 

 

 Errors when attempting to save the generated report to a specific 
folder (for example, out of disk space). 

 Errors when attempting to send the generated report via email (for 
example, the SMTP server configured in the GFI ReportCenter 
settings is not reachable). 
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The activity monitor records and enumerates the following information: 

 Date: The date and time when the scheduled report was executed. 

 Product name: The name of the GFI product to which the report 

belongs.  

 Type: The event classification - error, information, or warning.  

 Description: Information related to the state of a scheduled report 
that has been executed. The format and contents of the activity 
description vary, depending on the event type.  

NOTE: The description is often the most useful piece of information, 
indicating what happened during the execution of a scheduled report 
or the significance of the event. 

5.6  Enable/disable a scheduled report 

Scheduled reports can be enabled or disabled as required. Use the 
Scheduled Reports navigation button to view the list of scheduled 

reports as well as to identify their current status. The status of 
scheduled reports is shown through the icon included on the left hand 
side of each schedule: 

 
 Indicates that the scheduled report is disabled. 

 
 Indicates that the scheduled report is enabled/pending. 

To enable or disable a scheduled report, right-click on the respective 
report and select Enable/Disable accordingly. 

5.7  Editing a scheduled report 

To make changes to the configuration settings of a scheduled report: 

1. Click on the Scheduled Reports navigation button. 

2. Right-click on the scheduled report to be re-configured and select 
Properties. This will bring up the ‘Scheduled Reports Wizard’. 
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Screenshot 28 - Scheduled Reports wizard 

3. Click on Next and perform the required changes. For information on 

how to configure the parameters of a scheduled report refer to the 
‘Creating a scheduled report’ section in this chapter. 

Deleting a scheduled report 

To delete a scheduled report: 

1. Click on the Scheduled Reports navigation button. 

2. Right-click on the scheduled report to be permanently removed 
from the list and select Delete.  

5.8  Example: Scheduling a report 

This example demonstrates how to schedule a software audit report 
which will:  

 Generate the first report on 5/12/2009 at 8:00:00 PM. 

 Continue generating the same report on a monthly basis. 

 Export the generated report(s) to folder ‘C:\Monthly Reports’ in 
PDF format. 

 Email the generated report using the following custom parameters: 

 Send from email account: ‘RC_Admin@gfi.com’ 

 Send to email account: ‘IT_manager@gfi.com’ 

 SMTP server details: ‘120.11.120.11. 

To create the scheduled report: 

1. Click on the Default Reports navigation button. 

2. Right-click on Network Vulnerability Summary and select New ► 
Scheduled Report. As soon as the welcome dialog is displayed click 
Next. 
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Screenshot 29 - Select network security scan(s) data 

3. Select the option Scans over a date/time range for data to be 
covered by this report and click Next. 

 
Screenshot 30 - Select date/time of network scan 

4. Select the option Relative and from the provided drop down list 
select Last month. Click on Next to proceed to the next dialog.  
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Screenshot 31 – Specifying the scheduling options 

5. To generate this report on a monthly basis, select the option 
Generate this report every: and set the interval to 30 Days.  

6. Set the start date to ‘5/12/2009’ and time to ‘8:00:00 PM’. Click 
Next to continue.  

 
Screenshot 32 - Advanced Settings dialog 

7. From the Advanced Settings dialog, click on the Settings button 
underneath the Export to file option. 
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Screenshot 33 - Advanced Settings: Export to file options 

8. Select the option Override the default folder options for this 
report: 

9. Specify the complete path where this report will be saved i.e. 
‘C:\Monthly Reports’. 

10. From the report format drop down select PDF and click OK. 

 
Screenshot 34 - Advanced Settings dialog: Send by email settings button 

11. From the Advanced Settings dialog, click on the Settings button 
underneath the Send by email option. 
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Screenshot 35 - Report distribution options 

12. Select the option Override the default email options for this 
report: 

13. Specify the following parameters: 

 To: ‘RC_Admin@gfi.com’ 

 From: ‘IT_manager@gfi.com’ 

 Server: ‘120.11.120.11’. 

14. From the report format drop down select PDF and click OK to 
finalize your email settings. 
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Screenshot 36 – Custom report name and description 

15. Click Next and specify the following parameters: 

 Report Name: ‘Monthly report: ‘Software Audit’ 

 Report Title: ‘Software Audit – Executive reports’ 

 Report Description: This report is generated on a monthly basis 
and shows an executive summary of software installed on the 
network. 

16. Click Next to proceed to the final dialog. 

17. Click Finish to finalize your custom report configuration settings. 
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6.  Configuring default options 

6.1  Introduction 

The GFI LANguard ReportPack allows you to configure a default set 
of parameters which can be used when generating reports. These 
parameters are first set during installation. However, you can still 
reconfigure any of these parameters via the Options navigation 
button and the Tools menu provided in the GFI ReportCenter 

management console.  

 
Screenshot 37 - Options navigation button and Tools menu 

Through the Options navigation button you can configure the 
following parameter: 

Database source: Use this node to specify the database backend 
from where the ReportPack will extract the required reporting data.  
 

Through the Tools menu you can configure the following parameters: 
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 Default scheduling settings: Use this menu option to configure 
the default export to file parameters and report emailing 
parameters of scheduled reports. 

You can also backup your configuration settings for the ReportPack 
through the Import/Export Configuration node in the Options 

section. Exported configurations may be imported into a separate GFI 
ReportCenter instance, provided that the same ReportPacks are 
installed on both instances. 

6.2  Configuring database source: Microsoft SQL Server 

To configure MS SQL Server your database source: 

1. Click on the Options navigation button. 

2. Right-click on the Database Source node and select Set Database 
Source… This will bring up the database source configuration dialog. 

 
Screenshot 38 - Database source configuration dialog: SQL Server 

3. Select MS SQL Server as the database type from the provided list 

of supported databases. 

4. Specify the name or IP address of your MSDE/MS SQL Server 
database backend. 

5. To use the credentials of an SQL Server account, select the Use 
SQL Server authentication option and specify the user name and 
password in the provided fields.  

NOTE: By default, the GFI LANguard ReportPack uses Windows 
logon credentials to authenticate to the SQL Server. 
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6. Click on OK to finalize your configuration settings. 

6.3  Configuring database source: Microsoft Access  

To configure Microsoft Access as your database source: 

1. Click on the Options navigation button. 

2. Right-click on the Database Source node and select Set Database 
Source… This will bring up the database source configuration dialog. 

 
Screenshot 39 - Database source configuration dialog: MS Access 

3. Select MS Access as the database type from the provided list of 
supported databases. 

4. Specify the complete path to the database backend. If the database 
source is not stored locally, specify the complete path using Universal 
Naming Convention (UNC).  

(e.g.\\Security_Server\Program Files\GFI\LANguard9\ 
Data\scanresult.mdb). 

5. Click on OK to finalize your configuration settings. 
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6.4  Viewing the current database source settings 

 
Screenshot 40 - Database source configuration settings 

After configuration, you can view the current database source settings 
by clicking on the Database Source node. 

6.5  Configuring default scheduling settings 

To configure the default settings to be used by scheduled reports: 

 
Screenshot 41 - Default scheduling options node 

1. From the pull-down menu, click on the Tools ► Default 
Scheduling Options. 

2. Configure the required parameter as described in the ‘Configuring 
Advanced Settings’ section of the Scheduling Reports chapter. 
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6.6  Importing/Exporting the configuration 

 
Screenshot 42 – Import/Export Configuration node 

The GFI ReportCenter allows you to backup your configuration 
settings for the ReportCenter and all ReportPacks through 
Import/Export Configuration… in the File pull-down menu. Settings 

are exported for: 

 Default scheduling options 

 Custom reports 

 Scheduled reports 

 Favorite reports. 

The configuration is backed up into an XML file which may be 
imported into a separate GFI ReportCenter instance, provided that the 
same ReportPacks are installed on both instances. 

You can also import/export the configuration for a particular 
ReportPack through the Import/Export Configuration node in the 
Options section of the ReportPack 

.



 

44  Configuring default options GFI ReportCenter 

Exporting the configuration 

To export the GFI LANguard configuration: 

 
Screenshot 43 – Import/Export configuration dialog 

1. From the pull-down menu, click on the File ► Import/Export 
Configuration… . This will bring up the configuration dialog. 

2. Select the option Export configurations options. 

3. Specify which configuration options to export. 

4. Specify the path and filename of the XML file to export. Click on OK 
to proceed with the export. 
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Screenshot 44 – Export configuration success 
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Importing the configuration 

To import the GFI LANguard configuration: 

 
Screenshot 45 – Import configurations dialog 

1. From the pull-down menu, click on the File ► Import/Export 
Configuration… . This will bring up the configuration dialog. 

2. Select the option Import configurations options. 

3. Specify which configuration options to import. 

4. Specify the path and filename of the XML file to import. Click on OK 
to proceed with the import. 
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Screenshot 46 – Import configuration success 

 
Screenshot 47 - Import configuration success - restart notification 

5. Close and restart GFI ReportCenter to activate the imported items. 
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7.  General options 

7.1  Viewing the product ReportPack version details 

To view the version information of your product ReportPacks: 

1. Select the product ReportPack from the Product Selection drop 
down list. 

2. Click on the Options navigation button and select the Version 
Information node. The version details will be displayed in the right 

pane of the management console. 

7.2  Checking the web for newer builds 

Periodically GFI releases product and ReportPack updates which can 
be automatically downloaded from the GFI website. To check if a 
newer built is available for download: 

 
Screenshot 48 - Version Properties: Check for newer builds dialog 

1. Select the respective product (for example, GFI LANguard 9.0 
Reports) from the Product Selection drop down list. 
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2. Click on the Options navigation button. 

3. Right-click on the Version Information node and select Checking 
for newer builds… 

NOTE: GFI LANguard 9.0 ReportPack is configured by default to 
check for newer builds on startup. 
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8.  Appendix: GFI LANguard default 
reports 

8.1  Vulnerability assessment reports 

8.1.1  Network vulnerability summary 

 
Screenshot 49 – Sample report showing network vulnerability summary 

 
Chart displaying vulnerability severity distributions 

 
List showing the top 10 most vulnerable host machines ordered 
by severity 

 
Chart displaying vulnerability level distributions across host 
machines on the network  
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Screenshot 50 – Sample report showing network vulnerability summary 

 
Chart displaying the vulnerability distribution for each operating 
system on the network  

 
Screenshot 51 – Sample report showing network vulnerability summary 

 
Chart displaying vulnerability categories and their distribution 
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Screenshot 52 – Sample report showing network vulnerability summary 

 
Chart displaying the vulnerability distribution over time 

 
Screenshot 53 – Sample report showing network vulnerability summary 

 
Chart displaying the 10 most common vulnerabilities 

 
Chart displaying the 10 most vulnerable products 

Use this report to: 

 Display vulnerability counts for different categories 
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 Identify the 10 most vulnerable host machines 

 Identify the 10 most vulnerable products 

 Identify the 10 most common vulnerabilities. 

8.1.2  Network vulnerability trend 

 
Screenshot 54 – Sample report showing network vulnerability trend 

 
Chart displaying past scans and vulnerability totals for each scan 

 
List of past scans and respective scan profiles 

Use this report to: 

 Graphically illustrate how the number of vulnerabilities on the 
network has changed over a given time span. 

8.1.3  Vulnerability distribution by host 

 
Screenshot 55 – Sample report showing vulnerability distribution by host 

 
List of IP addresses and host names on which vulnerabilities were 
detected 

 
The number of low, medium and high severity vulnerabilities detected on 
each host 

 
The number of vulnerabilities detected on each host distributed by 
vulnerability category 



 

54  Appendix: GFI LANguard default reports GFI ReportCenter 

Use this report to: 

 Generate statistics showing vulnerability counts for each host 
machine. 

8.1.4  Vulnerability distribution by operating system 

 
Screenshot 56 – Sample report showing vulnerability distribution by operating system 

 
List of operating systems and service packs affected by one or more 
vulnerabilities 

 
The number of low, medium and high severity vulnerabilities detected on 
each operating system 

 
The number of vulnerabilities detected on each operating system 
distributed by vulnerability category 

Use this report to: 

 Generate statistics showing vulnerability counts for each operating 
system. 

8.1.5  Security scans history 

 
Screenshot 57 – Sample report showing security scans history 

 
List showing the host machines with the highest number of scans and 
the respective scan count 

 
List showing the host machines with the lowest number of scans and the 
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respective scan count 

 
Chart displaying scan profile usage 

 
Screenshot 58 – Sample report showing security scans history 

 

List showing date and time of the last scan performed on each host 

 

List showing all scans performed 

Use this report to: 

 Display information and statistics on all network security scans 
performed. 

8.1.6  Vulnerability listing by category 

 
Screenshot 59 – Sample report showing vulnerability listing by category 

 
Vulnerability details including name, description and severity 
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List of host machines affected by each vulnerability detected 

Use this report to: 

 List detected vulnerabilities grouped by category, and the host 
machines affected by each vulnerability. 

8.1.7  Vulnerability listing by host 

 
Screenshot 60 – Sample report showing vulnerability listing by host 

 
Host machine details on which vulnerabilities were detected 

 
Vulnerability count for each host, also shown as a percentage of total 
vulnerabilities detected on the network 

 
List of vulnerability details for each host, including name, description and 
severity 

 
Chart displaying percentage of vulnerabilities detected on each host 
compared to total vulnerabilities detected on the network 

Use this report to: 

 List the vulnerabilities detected for each host machine on the 
network. 
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8.1.8  Vulnerability listing by product 

 
Screenshot 61 – Sample report showing vulnerability listing by product 

 
Name of product for which vulnerabilities were detected 

 
Vulnerability details for each product, including name, description and 
severity 

 
List of host machines affected by each product vulnerability detected 

Use this report to: 

 List detected vulnerabilities grouped by product, and the host 
machines affected by each vulnerability. 

8.1.9  Vulnerability listing by severity 

 
Screenshot 62 – Sample report showing vulnerability listing by severity 

 
Severity level 

 
Vulnerability details for each severity level, including name and 
description 

 
List of host machines affected by vulnerabilities detected for each 
security level 
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Use this report to: 

 List detected vulnerabilities grouped by severity, and the host 
machines affected by each vulnerability. 

8.1.10  Open Trojan ports by host 

 
Screenshot 63 – Sample report showing open Trojan ports by cost 

 
Details of host machines having open ports associated with Trojans 

 
List of open ports for each host and the names of Trojans targeting each 
port 

Use this report to: 

 List open ports, grouped by host machine, which could potentially 
serve as a backdoor for Trojans. 

8.1.11  Open Trojan ports 

 
Screenshot 64 – Sample report showing open Trojan ports 

 
List showing the most common open Trojan ports detected on the 
network 

Use this report to: 

 List the 20 most common open ports found on the network, which 
could potentially serve as a backdoor for Trojans. 
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8.1.12  Top SANS vulnerabilities status 

 
Screenshot 65 – Sample report showing top SANS vulnerabilities status 

 
Host machine details on which vulnerabilities reported by SANS were 
detected 

 
List showing SANS vulnerability details, including name, description and 
product affected. SANS vulnerabilities are grouped by year and chapter 

Use this report to: 

 List the vulnerabilities detected for each host machine, based on 
the SANS top-20 report of vulnerabilities. 

8.1.13  Vulnerable hosts based on open ports 

 
Screenshot 66 – Sample report showing vulnerable hosts based on open ports 

 
List showing the top 20 host machines most likely to be compromised by 
Trojans 

Use this report to: 

 List the 20 most vulnerable host machines, based on the number 
of open Trojan ports found. 

8.1.14  Vulnerable hosts based on vulnerability level 

 
Screenshot 67 – Sample report showing vulnerable hosts based on vulnerability level 
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Host machine details showing the number of vulnerabilities and missing 
patches detected according to criticality 

Use this report to: 

 List the 20 most vulnerable host machines for each network 
security scan, based on vulnerability level. 

8.1.15  Network patching status 

 
Screenshot 68 – Sample report showing network patching status 

 
Chart displaying the number of installed and missing service packs 

 
Chart displaying the number of installed and missing patches, grouped 
by severity 
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Screenshot 69 – Sample report showing network patching status 

 
List showing the top 10 missing security updates 

 

List showing the top 20 most vulnerable host machines, as a result of 
missing patches and service packs. The number of vulnerabilities 
detected is split according to severity 

Use this report to: 

 Illustrate the status of patches and service packs for host 
machines on the network. 

8.1.16  Missing patches grouped by host 

 
Screenshot 70 – Sample report showing missing patches grouped by host 

 
Host machine details on which missing patches were detected 

 
List of missing patch details for each host, including severity and URL 
link for further information 

Use this report to: 

 List missing patches grouped by host machine, including URL links 
providing further information on each missing patch. 
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8.1.17  Missing patches grouped by operating system 

 
Screenshot 71 – Sample report showing missing patches grouped by operating system 

 
Missing patch details for each operating system 

 
List of host machines on which specific patches were found to be 
missing 

Use this report to: 

 List missing patches grouped by operating system, including the 
host machine names for each missing patch. 

8.1.18  Missing patches grouped by severity 

 
Screenshot 72 – Sample report showing missing patches grouped by severity 

 
Missing patch details for each severity level 

 
List of host machines on which specific patches were found to be 
missing 

Use this report to: 

 List missing patches grouped by severity, including the host 
machine names for each missing patch. 

8.1.19  Installed patches grouped by host 

 
Screenshot 73 – Sample report showing installed patches grouped by host 
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Host machine details on which installed patches were detected 

 
List of installed patch details for each host, including severity, URL link 
for further information and indication if the patch can be uninstalled 

Use this report to: 

 List installed patches grouped by host machine, including URL 
links providing further information on each installed patch. 

8.1.20  Installed patches grouped by operating system 

 
Screenshot 74 – Sample report showing installed patches grouped by operating system 

 
Installed patch details for each operating system 

 
List of host machines on which specific patches were found to be 
installed 

Use this report to: 

 List installed patches grouped by operating system, including the 
host machine names for each installed patch. 

8.1.21  Installed patches grouped by severity 

 
Screenshot 75 – Sample report showing installed patches grouped by severity 

 
List of installed patches grouped by their severity level, including 
information on each patch 

 
List of host machines on which specific patches were found to be 
installed 

Use this report to: 

 List installed patches grouped by severity, including the host 
machine names for each installed patch. 
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8.1.22  Remediation history by host 

 
Screenshot 76 – Sample report showing deployment history by host 

 
Host machine on which deployments were made 

 
List of deployment details for each host, including file names deployed, 
and deployment status 

Use this report to: 

 Display patches deployment information grouped by host machine, 
including deployment details such as date and status. 

8.1.23  Remediation history by date 

 
Screenshot 77 – Sample report showing deployment history by date 

 
Deployment starting date 

 
List of deployment details grouped by host, including file names 
deployed, and deployment status 

Use this report to: 

 Display patches deployment information by date and time, 
including details such as host machine names for each 
deployment. 

8.1.24  Remediation history by patch/application 

 
Screenshot 78 – Sample report showing deployment history by patch 
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Name of patch deployed 

 
List of host machines on which the patch was deployed and deployment 
details, including deployment status 

Use this report to: 

 Display patch deployment information grouped by patch applied, 
including details such as host machine names for each 
deployment. 

8.2  Network and software audit reports 

8.2.1  Software audit 

 
Screenshot 79 – Sample report showing software audit 

 
List showing the top 10 host machines with unauthorized applications 

 
List showing the top 10 unauthorized applications 
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Chart displaying the status of security applications on host machines 

 
List showing the top 20 installed applications 

Use this report to: 

 Identify unauthorized applications installed on host machines, 
detected during network security scans 

 Identify the top 10 host machines with unauthorized applications 

 Identify the top 10 unauthorized applications with highest number 
of installations 

 Identify the top 20 installed applications 

 Graphically represent the number of host machines without 
security applications, or with security applications not updated. 

8.2.2  Operating system and service pack distribution 

 
Screenshot 80 – Sample report showing operating system and service pack distribution 
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Chart displaying distribution percentage of each operating system on the 
network 

 
List of operating systems, including the number of host machines on 
which they are installed 

 
Chart displaying service pack distribution for each operating system 

 
List of operating system service packs, including the number of host 
machines on which they are installed 

Use this report to: 

 Graphically represent operating systems detected on the network 

 List the number of host machines for each operating system 

 Graphically represent service packs detected on the network for 
each operating system 

 List the number of host machines for each service pack installed. 

8.2.3  System information 

 
Screenshot 81 – Sample report showing system information 

 
Host machine IP and name 

 
Host machine details, including MAC address and domain 

 
Uptime details for each host machine, including time of day and uptime 
value 

 
Disk utilization details for each host machine, including drive name, file 
system type, total storage space and free storage space 
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Group and user details for each host machine, including group name, 
group members, user privileges and user bad password count 

 
Screenshot 82 – Sample report showing system information 

 
SNMP details for each host machine, including name and description 

 
Service details for each host machine, including name, description, 
status, startup type and account name 

 
Process details for each host machine, including process ID and account 
name 
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Screenshot 83 – Sample report showing system information 

 
List showing USB devices, blacklisted USB devices, network cards and 
black listed wireless devices 

 
Share folder details for each host machine, including name and remarks 

 
Open port details for each host machine, including port number and 
name 
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Screenshot 84 – Sample report showing system information 

 
Installed application details for each host machine, including name, 
publisher and version 

 
List showing password policy details security audit policy details 

 
List of registry entry details for each host machine 

Use this report to: 

 List detailed technical information for each host machine, including 
services, installed applications, policies and devices. 
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8.2.4  Computer properties 

 
Screenshot 85 – Sample report showing computer properties 

 
Host machine IP and name 

 
Host machine details, including MAC address and domain 

Use this report to: 

 List information for each host machine, including MAC address, 
network role and domain. 

8.2.5  Uptimes 

 
Screenshot 86 – Sample report showing uptimes 

 
Host machine IP and name 

 
Uptime details for each host machine, including time of day and uptime 
value 

Use this report to: 

 List uptime for each host machine, grouped by network scan. 

8.2.6  Disk utilization 

 
Screenshot 87 – Sample report showing disk utilization 

 
Host machine IP and name 
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Disk utilization details for each host machine, including drive name, file 
system type, total storage space and free storage space 

Use this report to: 

 List disk utilization information for each host machine, including file 
system type, total space and free space. 

8.2.7  Groups and users 

 
Screenshot 88 – Sample report showing groups and users 

 
Host machine IP and name 

 
List showing group details for each host machine, including name, 
description and members 

 
List of user details for each group, including user name, privilege, last 
logon and bad password count 

Use this report to: 

 List group and user information for each host machine. 
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8.2.8  SNMP information 

 
Screenshot 89 – Sample report showing SNMP information 

 
Host machine IP and name 

 
SNMP details for each host machine, including name and description 

Use this report to: 

 List SNMP information for each host machine, including name, 
description and uptime. 

8.2.9  Services 

 
Screenshot 90 – Sample report showing services 

 
Host machine IP and name 

 
Service details for each host machine, including name, description, 
status, startup type and account name 

Use this report to: 

 List service information for each host machine, including 
description, status, and startup type and account name. 
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8.2.10  Processes 

 
Screenshot 91 – Sample report showing processes 

 
Host machine IP and name 

 
Process details for each host machine, including process ID and account 
name 

Use this report to: 

 List process properties for each host machine. 
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8.2.11  Hardware Audit 

 
Screenshot 92 - Sample report showing hardware audit - part 1 of 2 
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Screenshot 93 - Sample report showing hardware audit - part 2 of 2 
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Host machine IP and name 

 
Processor information 

 
Motherboard information  

 
Physical and virtual memory 

 
Display adaptors 

 
Storage devices 

 
Drive name, space allocation and file system type 

 
USB device information 

 
Blacklisted USB devices 

 
Physical and virtual network devices 

 
Blacklisted network devices 

 
Other devices 

Use this report to identify all devices detected on the network for scan 
computers 

NOTE: Devices are grouped by categories. Categories with no 
devices detected are not displayed. 

8.2.12  Shares 

 
Screenshot 94 – Sample report showing shares 

 
Host machine IP and name 

 
Share folder details for each host machine, including name and remarks 

Use this report to: 

 List information on shared folders for each host machine. 
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8.2.13  Open ports 

 
Screenshot 95 – Sample report showing open ports 

 
Host machine IP and name 

 
Open port details for each host machine, including port number and 
name 

Use this report to: 

 List open ports detected for each host on the network including 
port number and name. 

8.2.14  Installed applications by Host 

 
Screenshot 96 – Sample report showing installed applications 

 
Host machine IP and name 

 
Installed application details for each host machine, including name, 
publisher and version 

Use this report to: 

 List installed applications detected for each network host scanned, 
including publisher and version details. 
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8.2.15  Application Inventory 

 
Screenshot 97 - Sample report showing applications inventory 

 
Installed application name and details 

 
List of computers having application installed 

Use this report to: 

 Identify all computers which have specific software installed on 
them. 

8.2.16  Antivirus Applications 

 
Screenshot 98 – Sample report showing installed anti-virus applications 

 
Host machine IP and name 

 
Antivirus application details for each host machine, including name, 
publisher and version 

 Use this report to: 

 List installed antivirus applications detected for each network host 
scanned, including publisher and version details. 
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8.2.17  Auditing Policies 

 
Screenshot 99 – Sample report showing policies 

 
Host machine IP and name 

 
Password policy details for each host machine, including minimum 
password length and password history 

 
List showing security audit policy details for each host machine 

Use this report to: 

 List password and security audit policy settings for each network 
host scanned. 

8.2.18  Registry information 

 
Screenshot 100 – Sample report showing registry information 
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Host machine IP and name 

 
List of registry entry details for each host machine 

Use this report to: 

 List system related registry information for each network host 
scanned. 

8.3  Results comparison 

8.3.1  Network security log by date 

 
Screenshot 101 – Sample report showing network security log by date 

 
Network security scans to be compared 

 
Host machine on which the comparison was made 

 

List of differences found between comparisons for each host machine. 
Differences are grouped by category, including backdoors, missing hot 
fixes, password policy, USB devices and applications 

Use this report to: 

 Compare results of consecutive scans that have a common profile 
and target, grouped by scan date. 
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8.3.2  Network security log by host 

 
Screenshot 102 – Sample report showing network security log by host 

 
Host machine on which the comparison was made 

 
Network security scans which were compared 

 

List of differences found between comparisons for each host machine. 
Differences are grouped by category, including backdoors, missing hot 
fixes, password policy, USB devices and applications 

Use this report to: 

 Compare results of consecutive scans that have a common profile 
and target, grouped by host machine. 



 

GFI ReportCenter Appendix: GFI LANguard default reports  83 

8.3.3  Baseline changes comparison 

 
Screenshot 103 – Sample report showing security settings comparison 

 

Details of the computer used as comparison standard, including scan 
date, and scan profile 

 

List showing host machines with which the standard computer was 
compared 

 

List of differences found when comparing the host machines with the 
standard computer. Differences are grouped by category, including 
backdoors, missing hot fixes, password policy, USB devices and 
applications 

Use this report to compare results between a chosen computer, used 
as benchmark, and host machines scanned with the same profile and 
having the same target. 
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9.  Troubleshooting 

9.1  Introduction 

The troubleshooting chapter explains how you should go about 
resolving any software issues that you might encounter. The main 
sources of information available to users are: 

 The manual – most issues can be solved by reading this manual. 

 GFI Knowledge Base articles 

 Web forum 

 Contacting GFI Technical Support  

9.2  Knowledge Base  

GFI maintains a Knowledge Base, which includes answers to the most 
common problems. If you have a problem, please consult the 
Knowledge Base first. The Knowledge Base always has the most up-
to-date listing of technical support questions and patches. To access 
the Knowledge Base, visit http://kbase.gfi.com/. 

9.3  Web Forum 

User to user technical support is available via the web forum. The 
forum can be found at: http://forums.gfi.com/.  

9.4  Request technical support 

If you have referred to this manual and our Knowledge Base articles, 
and you still cannot solve issues with the software, contact the GFI 
Technical Support team by filling in an online support request form or 
by phone. 

 Online: Fill out the support request form on: 
http://support.gfi.com/supportrequestform.asp. Follow the 
instructions on this page closely to submit your support request. 

 Phone: To obtain the correct technical support phone number for 
your region please visit: http://www.gfi.com/company/contact.htm. 

NOTE: Before you contact our Technical Support team, please have 
your Customer ID available. Your Customer ID is the online account 
number that is assigned to you when you first register your license 
keys in our Customer Area at: http://customers.gfi.com.  

We will answer your query within 24 hours or less, depending on your 
time zone. 

http://kbase.gfi.com/
http://forums.gfi.com/
http://support.gfi.com/supportrequestform.asp
http://www.gfi.com/company/contact.htm
http://customers.gfi.com/
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9.5  Build notifications 

We strongly suggest that you subscribe to our build notifications list. 
This way, you will be immediately notified about new product builds. 
To subscribe to our build notifications, visit: 
http://www.gfi.com/pages/productmailing.htm. 

http://www.gfi.com/pages/productmailing.htm
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